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COPYRIGHTS AND DISCLAIMERS 

 

Copyright © 2001-2008 Software, Inc. All rights reserved. 

FontAgent Pro 4 for Windows User Guide 

 

This manual and the software described in it are furnished under license and may be used only in 
accordance with that license. Except as permitted by the license, no part of this publication may be 
reproduced, stored in a retrieval system or transmitted by any means, electronic, mechanical, recording or 
otherwise, without the prior written consent of Insider Software, Inc. 

The contents of this manual are for informational use only and are subject to change without notice. In 
addition, the contents should not be construed as a commitment or guarantee from Insider Software, Inc., 
which also assumes no responsibility or liability for any errors on inaccuracies that may appear in this 
document.  

FontAgent is a registered trademark of Insider Software, Inc. Insider, the Insider logo, FontAgent Pro, Font 
Player, Font Compare and “The new face of font management and repair” are trademarks of Insider 
Software, Inc. 

Illustrator, InDesign, Photoshop, PostScript, Acrobat, Adobe and OpenType are trademarks of Adobe 
Systems Incorporated. QuarkXPress is a trademark of Quark, Incorporated. Windows is a trademark of 
Microsoft Corporation. Apple, Macintosh and TrueType are trademarks of Apple Computer. Other names 
mentioned are trademarks of their respective owners. 
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Welcome to FontAgent Pro 

Comprehensive Font Optimization and Management 

FontAgent® Pro for Windows is a complete font manager that optimizes and organizes your font files and 
lets you conveniently activate and deactivate them. By using FontAgent Pro, you save system resources, 
improve application performance, simplify font menus, guarantee the integrity of all your fonts, and save 
yourself a great deal of time and effort. 

FontAgent Pro also gives you a variety of powerful ways to view and compare your fonts in limitless text 
and color combinations so you can select perfect fonts for every project. Once you have, you can use 
FontAgent Pro to create sample documents to share your font selections with clients and associates. 

What’s new in Font Agent Pro 4? 

FontAgent Pro 4 is a comprehensive release that adds new font management power to FontAgent Pro’s 
industry leading feature set. New features in this major release are: 

• Full compatability with Windows Vista 
• Auto-activation Plugs ins for Adobe CS 2 and 3 applications including InDesign, Illustrator and 

Photoshop. 
• Wizard that helps you install you’re your auto-activation plug ins with just a few mouse-clicks. 
• Support for Package command in Adobe InDesign 
• Improve import and verification engine 
• Searching for fonts locally and on the internet with descriptive keywords 
• One-click access to information about internet fonts searches for more information or to purchase 
• Ability to set up a FontAgent Pro Database for each user on your computer 

Why Use FontAgent Pro? 

Eliminate Font Corruption and Duplication 

While many users take their fonts for granted, fonts can be a constant source of complication and trouble. 
Corrupt, incomplete and duplicate fonts cause many problems including application crashes, mysterious 
font substitution, and unexpected screen and printer output. 

FontAgent Pro is the flagship of Insider’s font management products, which for over a decade have led the 
industry in optimizing the integrity and usability of users’ font collections—making their systems faster 
and more stable.  

Build an Organized Font Library 

If you’re like most Windows users and store all your fonts in the Fonts Control Panel, you could be setting 
yourself up for trouble. While it’s nice to have all your fonts in one place, storing them there wastes 
precious system resources, slows your machine, bloats your Windows registry, and can make Font menus 
in applications unusable. On the other hand, storing fonts all over your hard drive is not a good solution 
either. If you do so, you have to drag fonts in and out of your Fonts Control Panel to activate and deactivate 
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them. It also makes it difficult to find the correct fonts to send to a client or a print service bureau. 
FontAgent Pro eliminates this dilemma by creating organized libraries containing optimized versions of all 
your fonts. 

Manage Your Fonts with Multiple Font Libraries 

Another cause of font frustration occurs when you receive fonts from other users. By adding those fonts to 
your collection, your Fonts Control Panel can become a disorganized mess containing unfamiliar fonts and 
multiple versions and formats of the same fonts. FontAgent Pro allows you to use multiple font libraries to 
store fonts from different clients or projects separate from your regular font collection so you can always be 
sure you are using the right fonts. 

Optimize and Archive Your Fonts Control Panel 

When you get a new Windows computer, its Fonts Control Panel contains a pristine collection of system 
fonts. Unfortunately, in a short while, that simple, clean collection becomes a dumping ground as you add 
font files from your personal collection on disk, from Internet downloads and from application installers. 
With a single command, FontAgent Pro restores order to your Fonts Control Panel, segregating the original 
system fonts from those that were added later. At the same time, it creates archives of all your font files so 
you can restore that configuration at a later date. 

Clarify Cryptic Font Filenames 

Most Windows fonts have cryptic filenames that defy human understanding. Looking for specific font files 
in Windows Explorer can be a very frustrating and fruitless exercise. For example, INTRI___.TTF is 
Interstate Regular Condensed, SCLBKBI.TTF is Century Schoolbook Bold Italic and BOD_BLAR.TTF is Bodoni 
Black. Using the font selection tools in FontAgent Pro, you’ll never have this problem again. In addition, as 
FontAgent Pro creates your optimized font library, you can optionally rename those cryptic font files with 
real names—without disturbing your original font files—so you know what font each file in your library 
contains even when you aren’t using FontAgent Pro. 

Reduce Font Clutter and Performance Problems 

As your font collection grows, it becomes imperative to activate just the fonts you need. If you activate 
many fonts at the same time, your computer and applications run slower and font menus become 
unmanageable. FontAgent Pro’s straightforward interface provides the tools you need to effectively 
manage your fonts, streamline your system, and keep font menus under control. 

Select the Right Fonts for Each Project 

Using FontAgent Pro, you can see all your fonts at all times, but activate just the ones you need. In doing 
so, you save system resources, improve your PC’s performance and simplify Font menus in applications. 
Finding the right font actually becomes a fun process again. 

FontAgent Pro includes many helpful previewing capabilities to assist you in selecting typefaces from your 
font library: 

• WYSIWYG (what you see is what you get) mode displays font names in their actual typefaces 
• Font Player™ automatically cycles through your fonts, displaying a slide show of a text string in 

various fonts one at a time 
• Font Compare™ displays a text string in multiple typefaces so you can see them at the same time 
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Using these tools, you can find the ideal typeface for every project. 

Print Font Sample Sheets and Books 

FontAgent Pro gives you the power to print font sample books and specimen pages. You can use these 
samples as hard-copy reference guides for selecting fonts or to share your font choices with others. 

About This Manual 

This user guide provides helpful information about how to use FontAgent Pro to manage fonts in 
Windows. You will also find helpful information in the FontAgent Pro Quick Start Guide and FontAgent 
Pro’s online help facility, as well as on the Insider Software website at HUwww.insidersoftware.comUH. 

Using Online Help and Resources 

FontAgent Pro includes an online help facility that you can access from its Help menu or by pressing the F1 
key. The help facility is designed to provide step-by-step instructions for managing your fonts with 
FontAgent Pro, as well as answers to common questions. 

Note also that more detail for your specific questions may also be available at 
HUwww.insidersoftware.com/supportUH, where you can find FAQs and obtain online assistance. 
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About Windows Fonts 

Windows requires you to place fonts in the Fonts Control Panel, which stores font files in the 
C:\Windows\Fonts folder. You can store fonts in other places on your hard drive, but until you install them 
in the Fonts Control Panel, Windows does not make them available to applications—unless you import 
them into FontAgent Pro and tell it to activate them for you. 

Windows supports multiple font file formats—including Windows TrueType, OpenType and Windows 
Type 1 PostScript fonts—making it easy to confuse various versions of the same font. To add to this 
complexity, it is often desirable to maintain those multiple versions for various uses. For example, you may 
wish to use an OpenType or Type 1 version of Futura for printed materials, but use the TrueType version for 
easy embedding in Microsoft Office documents. 

Windows makes this situation more complex by encouraging you to store all your font files in the Fonts 
Control Panel. Doing so prohibits you from using folders to organize your fonts, which makes it difficult to 
distinguish and manage them. 

Font File Formats Supported by Windows 

Format Description 

Windows 
Type 1 
PostScript 

(.pfb, .pfm files) 

Represents fonts as mathematical outlines. Spreads font data across various files, making it 
easy to lose important files. Widely regarded as the most faithful and reliable font format.  
If you share fonts with designers, printers and others in the creative business, this is the 
most widely supported font format. 

Windows 
TrueType 

(.ttf files) 

Represents fonts as mathematical outlines, storing all information in a single file. The 
quality differences between TrueType and PostScript fonts are hotly debated. In general, if 
you have a PostScript printer or share fonts with clients and service bureaus use PostScript. 
If you share documents with other Windows users, use TrueType. 

OpenType  

(.otf files) 

Can contain many more characters than previous formats. Capable of containing Type 1 
PostScript for Mac and Windows, and TrueType for Mac and Windows making it a powerful 
cross-platform format. This format is emerging as the new standard as it offers better 
typographical control.  

 
FontAgent Pro supports each of these formats and provides you with robust optimization capabilities to 
ensure that any font you import works properly. 
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Terminology You Should Know 

activation 

One of FontAgent Pro’s primary functions is font activation. When you activate a font, it becomes available 
to the operating system and the applications you run.  

archive 

A font archive is a zip file that FontAgent Pro creates when you optimize your Windows Fonts Control 
Panel. You can use the Restore Fonts Control Panel command to move the contents of archives back to your 
Fonts Control Panel. 

control panel fonts 

Control panel fonts reside in the Windows Fonts Control Panel, whose contents are stored in the 
C:\Windows\Fonts folder. Most Windows users store all their fonts in this location.  

designer 

A font’s designer is the name of the person that initially created the font’s outlines and characteristics. 

family 

A font family refers to all of the fonts of the same base design, such as Garamond, and includes all the 
variations of that font such as Garamond Bold, Garamond Italic, and Garamond Bold Italic. Note that font 
foundries do not consistently use the family designator consistently across all their fonts.  

font 
Technically, a font is a specific size and style of type such as Helvetica Condensed Italic 12 point. Many 
people also use the term font to refer to a font family such  
as Helvetica or to a font style such as Futura Italic. 

format 

A font’s format describes its internal file structure. Fonts used on Windows computers are usually TrueType, 
OpenType or Type 1. Type 1 format is also called Postscript format by some users.  

foundry 

A font’s foundry is the name of the vendor organization that distributes the font such as ITC, Adobe or 
Bitstream.  
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import 

When you import font files into FontAgent Pro, it reads their files from disk and stores their font outline, 
metrics and descriptive information in your font library. FontAgent Pro makes optimized copies of the fonts 
and leaves your original font files unchanged.  

library 

A font library is a physical collection of font files stored in your FontAgent Pro database. You can have one 
or many libraries in your database.  

optimized fonts 

When FontAgent Pro optimizes your fonts, it eliminates duplicates, corruption and unnecessary 
information, and places them in a FontAgent Pro library. 

pdf file 

A pdf file is a portable document format file. If you have the ability to create pdf files on your computer 
with a program such as Adobe Acrobat, you can use FontAgent Pro to create sample documents that you 
can share with others.  

point size 

Point size refers to the size of a font and is used in the user interface of applications as well as to identify 
files that define how a font appears at a specific size on screen.  

problem fonts 

If fonts fail integrity tests in the import process, FontAgent Pro places a copy of them in a folder called 
Problem Fonts, which resides in C:\FAP_Data or in the default data folder you specified when you 
installed FontAgent Pro. Since problem fonts are not imported, they do not appear in FontAgent Pro.  

required fonts 

Required fonts are fonts that the Windows operating system and associated applications need to run 
properly. If Windows does not find these necessary fonts in the Fonts Control Panel, it will often restore the 
fonts without informing you.  

sample book 

A sample book is a hard-copy reference guide that displays examples of your fonts so you can compare and 
select them. 

set 

A set is a group of fonts that can span any number of font libraries. You can use a set to organize fonts you 
need for specific projects or documents into a single group. For example, when you activate a set, you 
activate all the fonts in that set, making them available for use in your applications. 

specimen sheet 

A specimen sheet is an electronic or hardcopy page that displays text in one or more fonts so you can 
compare and present them.  
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subset, cascading set, nested set 

A subset is a FontAgent Pro set that is part of another set. Subsets are sometimes called nested sets or 
cascading sets. 

startup item 

A startup item is a font or a group of fonts such as a family, set or library that FontAgent Pro activates 
automatically every time it starts up.  

style 

The style of a font is a variation of a base font. A few examples of styles include bold, italic, bold italic, 
roman, regular, normal and black. 

substitution 

Font substitution occurs in software applications when you open a document that calls for fonts that are 
not activated. When this occurs, the applications can substitute a similar font for the missing font. If you 
find and activate the missing font, some applications immediately re-display the font correctly, while 
other applications must be restarted to display text correctly in the newly activated font. 

typeface 

The term typeface is used interchangeably with the term font, though many people use typeface to refer to 
a font family name such as Palatino.  

weight 

A font’s weight refers to thickness of the strokes in each letter or glyph in the font. The standard weight for 
fonts can be called book, roman, regular, normal, or carry no indicator at all (as in Arial). Heavier weights 
include descriptors such as bold, extra bold, semibold, medium, black, ultra black and heavy. Examples of 
lighter-weight descriptors include light, extra light, thin and hairline.  

width 

The width of a font refers to how the breadth of each complete letter or glyph compares to its standard, 
normal width. Smaller-than-normal width descriptors include compressed, condensed, compact and 
narrow. Examples of wider-than-normal widths include expanded, extended, wide, and double-wide.  
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Importing Fonts 

To organize and manage your fonts, you must import them into FontAgent Pro. When you import fonts, 
FontAgent Pro checks their integrity, optimizes them, organizes them in your font library, and stores 
information about their characteristics. You can then display your fonts in various ways so you can select, 
manage and activate them. 

Specifying a Default Database Location 

The first time you launch FontAgent Pro, it asks you to specify a folder location where it initializes your font 
database. Accept the default folder of C:\Users\username\AppData\FontAgent Pro Data\ or click the Browse 
button to select another folder location on a hard drive on your computer.  

 

Note: When you run FontAgent Pro 4, your database will be updated as well. This new database is not 
backward compatible with FontAgent Pro 3.  If you are running the FontAgent Pro 4 demo and think you 
may want to go back to version 3, make sure you back up the database before upgrading. 

When you have selected where you want to store your fonts, click Create FontAgent Pro Folder and 
FontAgent Pro creates an empty folder in that location. Once you initialize your database, in subsequent 
sessions of FontAgent Pro, it will find that database and you will not see this dialog. 

 
Note: If you move your database after you create it, the next time FontAgent Pro starts, it will be unable to 
find the database, and this dialog will appear again. Click the Browse button and a file selection dialog 
appears. Navigate to the location where you moved your database, select it and FontAgent Pro will restart 
as usual. 

 



 

Optimizing Your Fonts Control Panel 

Most Windows users store many of their fonts in the Fonts Control Panel. FontAgent Pro provides a 
convenient command for importing and optimizing those fonts. 

Important: If you are running Microsoft Vista and you have User Account Control turned on, you will need 
to run FontAgent Pro as administrator to optimize your Control Panel Fonts. To do this you need to right 
click on the  FAP4_0.exe  icon and select  Run as administrator 

Initially Optimizing Your Control Panel 

When FontAgent Pro starts and detects an empty font database, it helps you add initialize the database 
with fonts. The most efficient way to do so is to optimize your Fonts Control Panel.  

 

To begin the optimization process, click Optimize Control Panel and the following dialog appears. 
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Unless you have specific reasons for doing otherwise, leave all the checkbox options checked and click 
Proceed. 

At any later time, you can optimize your Control Panel again by selecting Optimize Fonts Control Panel from 
the Tools menu. This is particularly helpful if you have added fonts to your Control Panel since you last 
optimized it. 

What Happens When You Optimize Your Control Panel 

When you optimize your Windows Fonts Control Panel, FontAgent Pro: 

• Tests the integrity of each font 
• Adds the font files to zip archives, 

creating a convenient backup copy 
• Moves fonts not required by 

Windows to a new file location to 
save you system resources and Font 
menu clutter 

• Creates two libraries in FontAgent 
Pro—one for fonts required by 
Windows and one for all your other 
fonts 



 

The Required Fonts library 

Windows operating systems ship with a set of fonts that they expect to be available at all times. When you 
optimize your Fonts Control Panel, FontAgent Pro identifies these fonts and: 

• Places the fonts in a library called Required Fonts 

• Leaves their associated physical font files in the C:\Windows\Fonts folder so Windows can find 
them 

• Places a PC-shaped icon to the left of each font name so you know it resides in the Fonts Control 
Panel 

• Adds a copy of the font files to a backup zip archive for your safety and convenience 
• Locks the fonts in FontAgent Pro so they cannot be deleted from the Required Fonts library  

 

• Prohibits you from accidentally deactivating the fonts 

Note: FontAgent Pro allows you to import Windows-required fonts into other libraries as well. In those 
libraries, the system fonts behave like any other font and can be activated, deactivated and deleted. 

To restore your original Required Fonts at any time, select the Restore Fonts Control Panel command from 
the Tools menu. For details, see HURestoring Your Fonts Control PanelUH in this user guide. 
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The Control Panel Fonts library 

If you have added fonts to your Windows system, they probably reside in your Fonts Control Panel 
alongside the fonts that came with Windows. When FontAgent Pro optimizes your Fonts Control Panel, it 
finds all the fonts you’ve added and: 

• Places the fonts in a library called Control Panel Fonts 

• Activates the fonts during your current FontAgent Pro session 
• Allows you to activate and deactivate the fonts as you require 
• Moves their associated physical font files from the C:\Windows\Fonts folder to the C:\Documents 

and Settings\FontAgent Pro\Libraries folder so Windows does not activate them accidentally 
• Adds a copy of the font files to a backup zip archive for your safety and convenience 

Note: FontAgent Pro places fonts that ship with the Windows operating system in a library named Required 
Fonts and not in the Control Panel Fonts library. 

At any time, if you want to restore the fonts originally residing in your Fonts Control Panel, select the 
Restore Fonts Control Panel command from the Tools menu. For details, see HURestoring Your Fonts Control 
PanelUH in this user guide. 



 

Importing Fonts via Drag-and-Drop 

The easiest way to import fonts into FontAgent Pro is to drag and drop font files or folders containing font 
files into the All Fonts tab. FontAgent displays the following dialog so you can select a library into which 
you wish to import the new fonts. 

 

 

Option Effect of Option 

Rename imported font files 
to real font names 

Renames font files imported into FontAgent Pro from cryptic names to real font 
names. Leaves names of original font files unmodified. 

Activate fonts after 
importing them 

Activates fonts in Windows after importing them into your FontAgent Pro library.  
If you are importing large numbers of font files, to save system resources and keep 
font menus simple, do not check this option. 

Show report after importing Displays a report detailing good fonts that were imported correctly, as well as 
damaged, duplicate and unmatched fonts that failed to import and are now 
quarantined in the Problem Fonts folder, which resides in the same location as your 
FontAgent Pro database folder.  Problem fonts do not appear in FontAgent Pro. 

Destination Library Designates the library name into which to import fonts. To create a new library, click 
New and enter the new library’s name. 

 
Select the options you wish, click Import Fonts and FontAgent Pro imports the fonts into the library you 
selected. 
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Importing Folders of Fonts 

You can import an entire folder of fonts into FontAgent Pro using the Import button on the toolbar or the 
Import Fonts command in the File menu. 

Toolbar 

Click the Import button in the toolbar. A dialog box appears, allowing you to choose a folder location. 
FontAgent Pro imports all fonts it finds in the folder. 

File menu 

Select Import Fonts from the File menu. A dialog box appears, allowing you to choose a folder location from 
which you can select fonts to import. FontAgent Pro finds all fonts in the folder and imports them. 

When you make an import request, the following dialog appears. 
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Using the dialog, you can:  

• Select the folder from which you wish to import fonts 
• Specify the name of the Destination Library into which you plan to import the fonts  

When you install FontAgent Pro, it creates a default library named My Fonts. You can select this default 
library or create a new one by entering any alphanumeric name you wish.  In general, if you do not have a 
good reason for creating a new library, you should just import the fonts into an existing one. 

If FontAgent Pro detects that a copy of a font being imported already resides in the destination library, it 
does not import the font and produces a warning in the import log. 

Use the following options to control how FontAgent Pro imports folders of fonts. 
 

Option Effect 

Rename imported font files 
to real font names 

Renames font files imported into FontAgent Pro from cryptic names to real font 
names. Leaves names of original font files unmodified. 

Activate fonts after 
importing them 

Activates fonts in Windows after importing them into your FontAgent Pro library.  
If you are importing large numbers of font files, to save system resources and keep 
font menus simple, do not check this option. 

Show report after importing Displays a report detailing good fonts that were imported correctly, as well as 
damaged, duplicate and unmatched fonts that failed to import and now reside in 
the Problem Fonts folder, which resides in the same location as your FontAgent Pro 
database folder.  

Destination Library Designates the library name into which to import fonts. To create a new library, click 
New and enter the new library’s name. 

 
When you are finished setting import options, click Find & Validate Fonts and FontAgent Pro begins 
locating fonts in the folder you selected and testing their integrity as described below. 
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What Happens When You Import Fonts 

After you click Find & Validate Fonts, FontAgent Pro: 

1 Finds all fonts in the specified folder and subfolders. 
2 Runs extensive integrity tests to check for corrupt fonts. 
3 Identifies duplicate fonts and imports only unique fonts.  
4 Identifies all unmatched PostScript fonts and does not import them. 
5 Stores important descriptive information about each font in its database. 
6 Creates a Problem Fonts folder inside your FontAgent Pro database folder, and places fonts 

failing integrity tests into subfolders according to the nature of the failure. 

The first feedback you will see is the Fonts Found and Tested dialog. 

 



 

 
FontAgent Pro 4 User Guide 21 

 
This dialog summarizes the results of the font integrity tests run by FontAgent Pro. Each font is classified 
into one of the following categories. 

Diagnosis Description Import Status 

Corrupt fonts Found internal problems with the font data inside 
the file.  Not importable 

Incomplete fonts Did not find all the required files that make up the 
PostScript font.  Not importable 

HFileH errors Found one or more errors in the file structure of the 
font file. 

Not importable 

Fonts already in 
library 

Found a copy of the font in the FontAgent Pro 
library you selected as the target library. Not importable 

Duplicate fonts Found more than one copy of the same font in the 
selected folder. 

Import one instance of font  
if checkbox is checked 

Importable fonts Found no problems with the font, so it is ready to be 
imported. 

Import font if checkbox is 
checked 
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Select the fonts to import 

By default, FontAgent Pro imports all Importable Fonts and one instance of Duplicate Fonts. To skip 
importing some of these fonts, uncheck the checkbox  
next to their name. 

When you are finished selecting which fonts to import, click Import Fonts and FontAgent Pro displays a 
dialog showing you the progress of your import request. When the process completes, an Import Results 
dialog appears as shown below. 

 

Review the dialog to verify the results of your import request. To save the report as a text file, click Save a 
copy…, and then enter a name for the new file. When you are finished reviewing the results dialog, click 
OK to continue working. 

Using this importing approach, FontAgent Pro: 

• Removes all corrupt, incomplete and duplicate fonts so you can depend on the integrity of your 
fonts 

• Preserves your original font files 
• Adds only unique fonts so you don’t have to worry about searching for duplicates manually 
• Ensures that you do not import duplicate copies of fonts into a library 

Using the Last Import set 

FontAgent Pro automatically maintains a set named Last Import containing the fonts from the last import. 
You can rename this set after importing your fonts. The next time you import fonts, FontAgent Pro will 
create a new Last Import set for you. 
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Importing Fonts Installed by Applications 

Some applications—including Adobe Creative Suite—install fonts in various folders. When this occurs, 
you might notice one of the following conditions: 

• Fonts listed in font menus vary from application to application 
• Fonts appear in applications even though you haven’t activated them 
• An unfamiliar font or set of symbols appear in an application 

If you wish to manage these application-specific fonts, please check with the application’s developer to 
determine that they can be moved safely. If the application expects to find the fonts where they were 
initially installed, your moving them could result in the application functioning improperly or appearing 
strangely. Until you know that it is safe to move application fonts, it is safer to leave them in the folder 
where they are now. 
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Restoring Your Fonts Control Panel 

At any time, if you want to restore the fonts originally residing in your Fonts Control Panel, select the 
Restore Fonts Control Panel command from the Tools menu. You might use this command when: 

• You accidentally delete font files from the Fonts Control Panel or elsewhere 
• You want use your system without running FontAgent Pro 

When you run this command, FontAgent Pro asks you to select which fonts you wish to restore. 

 

The archives contain copies of any fonts that FontAgent Pro found when you optimized your Fonts Control 
Panel. In other words, if you have run the command five times, the archives contain the union of all fonts 
that FontAgent Pro found on all five occasions. The Required Fonts archive contains copies of all fonts that 
ship with Windows, while the Control Panel Fonts archive contains all other fonts found by FontAgent Pro. 

Select one or both of the font archives, click OK, and FontAgent Pro restores the fonts in the archives to 
your Fonts Control Panel. 

Note: You can optimize your Control Panel Fonts as often as you need to without worrying about adding 
duplicate fonts—since FontAgent Pro adds only fonts not yet imported into your font library. 



 

Using the FontAgent Pro Interface 

FontAgent Pro’s straightforward interface allows you to quickly perform font management tasks. 

 
 

Toolbar 

Right Work Area 

Left 
Work 
Area 

Preview Area 

Interface Area Function 

HToolbarH Provides buttons for frequently used commands. 

Left Work Area 
The All Fonts tab displays a list of all imported fonts. This pane can also display sets 
or libraries by clicking the appropriate tab. Use these additional views of Sets and 
Libraries tabs to compare different sets or libraries and drag fonts between them.  

Right Work Area Displays sets and libraries, and the fonts they contain. Click the tab labeled Sets or 
Libraries to switch views.  

Preview Area 
Displays the selected font or the first font in a family, set or library. See the sections 
entitled Using Font Player and Using Font Compare for more information.  
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Minimizing the Font Agent Pro Window places FontAgent Pro in the Tooltray. To bring the FontAgent Pro 
interface back in to focus, double-click on the FontAgent Pro  icon in  the Tooltray.  

Viewing Font Information 

All Fonts, Libraries and Sets Tabs 

FontAgent Pro displays descriptive information about each of your fonts in the  All Fonts, Libraries and Sets 
tabs as explained below.  

Descriptive Font Information 

Column Function 

Activation Status 

 

Displays the activation state of the item: 

 

Lock Status Indicates whether the item is locked or unlocked: 

(no icon) Unlocked font, set or library 
Locked font, set or library 
Font or subset that is locked because it is a member of a locked set or library 

File Format Displays the file type of the font:  

 

Name Displays font, family, set or library names. 

Startup If a curved up-arrow appears at the right side of the Name field, FontAgent Pro 
activates this font, set or library at startup. 

  

Foundry Displays the name of the font's foundry. 

Items Displays a count of the number of items in a family, set or library.  

Library Displays the name of the library in which the font resides. 

Deactivated font, family, set or library 
Family, set or library containing activated and deactivated fonts 
Fully activated font, family, set or library 
Activated font residing in the Windows Fonts Control Panel 
Duplicate of activated font residing in the Window s Fonts Control Panel 

Windows TrueType font 
Type 1 PostScript font 
OpenType font 



 

Item Properties 

To view the properties of a font, set or library, do one of the following: 

• Double-click the item’s name 
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ro 
ng the contents of the folder containing the font file. 

• Right-click the item’s name and select 
Properties from the pop-up menu 

• Select the item and choose the Properties 
command from the Font menu 

You can add helpful comments to the Notes field 
such as: 

• The names of clients using this font or item 
• Projects, publications and documents that 

use the font 
• Fonts or styles that appear similar to this 

item 
• Licensing details and font vendor contact 

information 

Font File Location 

To view the disk file associated with a font, right-
click the font’s name and select  
Show Font from the pop-up menu. You can also 
select the item and choose the Show Font 
command from the Font menu. FontAgent P

then opens a Windows Explorer window showi
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Column Headings 

Clicking on a column heading in FontAgent Pro sorts the items displayed by  
the values in that column. For example, clicking the Name heading sorts fonts alphabetically by name 
while clicking Library sorts fonts by the library in which they reside. You can drag the vertical line between 
headings to resize a column. 

 

Selecting Fonts  

You can select fonts, families, sets and libraries in various ways.  

Click 

Click an item to select only that individual item. 

Shift-click 

To select a continuous range of items, click the first item, hold down the Shift key and click the last item.  

Ctrl-click 

To select multiple items not in a continuous range, hold down the Ctrl key and click the items. To de-select 
an item, click it again while holding down the Ctrl key. 

Ctrl-a 

To select all items in a list, click on it, hold down the Ctrl key and type a. 



 

Adjusting Interface Panes 

FontAgent Pro provides two panes or work areas where you can display the All Fonts, Libraries and Sets lists 
so you can view fonts and use drag-and-drop functionality to manage them. The lower-right pane lets you 
preview fonts using the Font Player and Font Compare viewers. You can adjust the position of FontAgent 
Pro's interface panes to simplify your workflow. 

Change a pane’s view  

Click the appropriate tab to change the view in each pane. 

Resize panes 

Click and drag the divider bar between panes to resize them.  

Resize the window  

Click and drag the bottom right of the FontAgent Pro window to resize it. 
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Using the All Fonts Tab 

The All Fonts tab is a convenient view of all the fonts you have imported into FontAgent Pro. It displays all 
fonts in all libraries.  

Filter field 

To display only items containing a specific 
text string, enter text in the Filter field 
and click Find. FontAgent Pro displays the 
items that pass the filter in purple. To 
cancel the filter, click Clear.  

Number of fonts 

A count of all fonts you in your FontAgent 
Pro database appears at the top left of the 
All Fonts tab. 

By family 

If By Family is checked, FontAgent Pro 
groups typefaces into font family names 
provided by font vendors inside font files. 
Since there are no definitive rules for 
assigning family names, some fonts such 
as Times New Roman appear in one family, 
while others appear in more than one 
family such as Myriad Pro, Myriad Pro 
Bold, etc. If By Family is unchecked, 
FontAgent Pro lists all typefaces individu-
ally in alphabetical order. 

WYSIWYG (UwUhat UyUou UsUee UiUs UwUhat UyUou UgUet) 

If checked, FontAgent Pro displays individual font name in their native typefaces. The WYSIWYG setting 
has no affect on the appearance of family names.  

Sort by font name or family name 

You can sort the list of fonts in the All Fonts tab by clicking its column headers. 

• Click the Name column to sort by font or family name 
• Click the column heading above the circular activation icons to quickly see all activated fonts, 

which appear as spheres 
• Click the Foundry column heading to quickly see all the fonts from a specific font foundry 



 

Scrolling to an item 

To scroll to the first occurrence of a font, family, set, or library listed in a tab, click the tab and type the first 
letter or first few letters of its name. FontAgent Pro scrolls to the first displayed occurrence of the item. If 
an item is hidden inside a +/- expansion box, FontAgent Pro skips over it when scrolling. 

You can also use the scrollbar appearing on the right of a pane to scroll through the items listed in the 
pane. 

Using the Toolbar 

The toolbar provides buttons for frequently used FontAgent Pro commands.  

 

 
Toolbar Functionality 

Toolbar Item Function 

Activate Activates selected fonts, families, libraries or sets. 

Deactivate Deactivates selected fonts, families, libraries or sets. 

Lock Locks selected fonts, families, libraries or sets.  

Unlock Unlocks selected fonts, families, libraries or sets. 

New Library Creates a new library in which you plan to store fonts. 

Import Opens a window to select a folder of fonts to import.  

New Set Creates a new, empty set and lets you specify a name for it. If you selected a set before 
clicking New Set, it makes the new one a subset of the selected set. See Working with 
Cascading Sets.  

Remove Deletes the selected fonts, libraries or sets from your FontAgent Pro library. 

Search Opens the Keyword Search window.  See Using Keyword Search. 
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Deleting Fonts 

In FontAgent Pro, there is an important difference between deleting a font from a library and removing it 
from a set. Deleting a font from a library or from the All Fonts tab actually deletes the physical font file 
from your hard drive. To use the font again, you must re-import the font into your FontAgent Pro database. 

In contrast, removing a font from a set does not delete the font file from your hard drive. You can safely 
remove fonts from sets without worrying about permanently deleting fonts.  

Deleting fonts from All Fonts tab 

Deleting fonts from the All Fonts tab permanently deletes the selected fonts from your font database. To 
do so, select a font or group of fonts in the All Fonts tab and click the Remove button in the toolbar. A 
dialog box asks you to confirm that you wish to delete the selected items. You cannot delete locked fonts 
such as those residing in the Required Fonts library. If you attempt to do so, FontAgent Pro displays a dialog 
explaining the situation. 

Deleting fonts from libraries 

Deleting a font removes it permanently from the library containing it. To do so, select a font, group of fonts 
or library and click the Remove button in the toolbar. A dialog box appears asking you to confirm that you 
wish to delete the selected fonts.  

Usage tip: If you are unsure if you have a backup copy of a font, first create a copy by exporting the font and 
then delete it.  

Removing fonts from a set 

Select a font or group of fonts in a set and click the Remove button in the toolbar. FontAgent Pro removes 
the selected fonts from the set, but leaves their font files in your FontAgent Pro database.  

 

 



 

Using Keyword Search 

To help you find the fonts you need, FontAgent Pro’s Keyword Search facility finds fonts that match 
keywords describing their appearance, category, usage and other attributes. For example, you can enter 
terms such as Western or Italian Restaurant, and FontAgent Pro displays a list of fonts that match those 
keywords.  

 

Searching for Fonts by Keyword 

To search for a font by keyword, follow these steps: 

1 Click Search in the Toolbar 
2 Enter keyword search text 
3 Select Search 

Keyword Search returns a list of fonts that match your text entry. To see a preview of what the fonts look 
like, click the Show Samples checkbox. To change the size of the sample view, click the up- or down-arrow. 

Find Fonts Locally and on the Internet 

The Keyword Search facility not only finds fonts in the FontAgent Pro library located on your computer, it 
also finds fonts on the Internet that match the keywords you specify.  

When you search by keyword, FontAgent Pro first displays fonts matching your text string that reside on 
your computer. You can activate and deactivate these fonts by clicking on the activation sphere appearing 
to the left of their names.  
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After the list of local fonts that match your search criteria, Keyword Search displays a list of matching fonts 
it finds on the Internet.  To learn more about these fonts, double-click a font name on FontAgent Pro 
launches an internet browser window displaying a web page with additional information about the font 
and how to purchase it. 

Keyword Search returns the fonts it finds by relevance, or by how closely they match the keyword. If you 
do not see any local returns on the initial screen, you can browse through the returned fonts by clicking the 
right and left arrows in the showing hits section. 

Exiting Keyword Search  

To exit the Keyword Search facility, click the close button in the upper right corner of the Keyword Search 
Window.  



 

Working with Sets 

Sets in FontAgent Pro are logical groupings of your fonts that can span across multiple font libraries. For 
example, you might want to organize your fonts into sets based on customer, project or font appearance. 
Creating, modifying and deleting sets does not affect your physical font files, so feel free to experiment 
with sets.  

Should I Organize My Fonts in Libraries or Sets? 

In general, you should keep your fonts in a single library—separate from the Required Fonts library—and 
use sets to organize the fonts into logical groups. However, there are situations in which multiple libraries 
are preferable for storing your font collection. FontAgent Pro lets you create multiple libraries so you can: 

• Store customer and third-party fonts separately from your fonts and remove them easily 
• Keep multiple versions or tweaked copies of the same fonts 
• Duplicate exact copies of the same fonts 

The decision to create a new font library is not a critical one since FontAgent Pro allows you to use as many 
libraries as you like and to define sets that span libraries.  

Note: FontAgent Pro allows only one instance of a font to reside in a library. If a font appears more than 
once in the All Fonts tab, the fonts are either in different libraries or they are not exact duplicates.  

Creating Sets 

FontAgent Pro lets you create sets to group your fonts in meaningful ways and ease font management 
tasks for your projects.  
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Creating a new set 

To create a new set, either click the New Set icon in the toolbar or select New Set from the File menu. 
FontAgent Pro creates a set called New Set and selects its name so you can enter a new name for the set. 

Creating subsets 

FontAgent Pro allows you to create nested or cascading sets—subsets within sets—for easy font 
organization. Subsets provide a great deal of flexibility to help you manage your projects and maintain 
your font libraries. As you become more experienced with FontAgent Pro, you will discover many helpful 
uses for sets and subsets. Here’s an example of how to use subsets to manage various projects for a single 
client or department creating catalogs, flyers and signs that use many of the same fonts: 

1 Create an empty set and name it for the client or project. 
2 Click the set to highlight it. 
3 Select New Set from the toolbar. 

 



 

Renaming Sets 

To change the name of a set, right-click its name, select Rename from the pop-up menu, enter the new 
name and press Return. 

Deleting Sets 

To delete a set from your FontAgent Pro library, right-click its name and select Remove. Alternatively, after 
making your selection, you can click the Remove icon  
in the toolbar, select the Edit>Remove menu command, or press the Delete key. When you remove a set, 
you delete only the logical association of fonts, not the actual font files. 

Copying Sets 

Copy a set by dragging and dropping it from its current location into a new set. You can drag fonts from 
the All Fonts tab and a Sets tab or between two Sets tabs. Note that dragging a set to a new location does 
not delete the original set. 

Adding Fonts to Sets 

You can easily add fonts to existing sets to keep your sets up-to-date. To do so, select a font or group of 
fonts and drag those fonts into a set. 

Designating Startup Sets 

To automatically activate all the fonts in a set when FontAgent Pro starts up, right-click the set and select 
Add to Startup Items. To stop a set’s fonts from activating at startup, right-click it and select Remove from 
Startup Items. For more information, see HUActivating Items at StartupUH. 

Locking Sets 

When you lock a set in FontAgent Pro, you cannot modify or delete it, 
but you can activate it. To lock a set, right-click it and select Lock. To 
unlock a set so you can modify or remove it, right-click it and select 
Unlock. For more information, see HULocking Fonts, Families, Sets and 
Libraries.U 
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Activating Fonts, Families, Sets and Libraries 

Activating a font makes it available to other applications and makes the font  
appear in font menus throughout your system. Some Windows applications—including Microsoft Word, 
PowerPoint and Outlook—automatically update their font menus and make newly activated fonts 
immediately available. Other Windows applications load information about open fonts when the 
applications first start, so you must re-launch them before they can use newly activated fonts.  

Activating a font loads it into your system’s memory. A major benefit of using FontAgent Pro is that you 
can activate only the fonts you currently need, keeping your system resources free and your font menus 
streamlined.  

With FontAgent Pro you can activate an individual font, a font family, a set or an entire font library. To the 
far left of every item’s name, FontAgent Pro displays an icon that indicates its activation status.  

 Deactivated font, family, set or library 
Family, set or library containing activated and deactivated fonts 
Fully activated font, family, set or library 
Activated font residing in the Windows Fonts Control Panel 
Duplicate of activated font residing in the Window s Fonts Control Panel 

 

 

Important: FontAgent Pro does not allow you  to activate a duplicate of an activated  font residing the 
Windows Fonts Control  Panel. Activation of these fonts is not permitted by Windows, because the fonts 
are already active and available to your applications as a resident of the Windows Fonts Control Panel. 

Activating and Deactivating Fonts Manually 

To manually control the activation status of an item, click the 
activation sphere next to its name.  
If an item is currently deactivated, clicking its activation sphere 
activates the item. If the item is already activated, clicking its activation sphere deactivates it.  

If a lock icon appears next to an item’s name, that item is locked, but can still be activated and deactivated.  

You can also select any group of fonts, families, sets or libraries and click the Activate or Deactivate button 
in the toolbar. If a selected item is partially activated, clicking the Activate icon activates the remaining 
fonts in the item. 



 

Activating Fonts Automatically in Applications 

FontAgent Pro now provides autoactivation plug-ins for Adobe Creative Suite 2 and 3 including Photoshop, 
Illustrator and InDesign. To activate fonts automatically, you must have the FontAgent Pro auto-activation 
plug ins installed. See Installing Auto-Activation Plug-Ins for more information 

Setting Preferences for Auto Activation  

FontAgent Pro gives you several ways to control the way auto activation behaves so you can customize the 
application to best suit your workflow.   

 

To specify how you want auto activation to behave, select Preferences from the Edit menu . Under Auto-
activation select: 

 

Option Description 

Enable auto-activation of fonts Enables auto-activation when the FontAgent Pro auto-
activation plug-ins are installed. 

Deactivate auto-activated fonts 
when closing documents 

Automatically deactivates fonts auto-activated for a 
document when it is closed When unchecked, fonts auto-
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Option Description 

activated are left active. 

Show font deactivation alert 
before deactivating auto-
activated fonts 

Displays a dialog when you close a document that lets you 
selectively deactivate or leave active the fonts auto-activated 
for a document. 

 

Note: FontAgent Pro must be running for auto-activation to function. If you do not have Font Agent Pro 
running and you use an application that has an auto-activation plug in installed you will receive the error 
message below:  

 



 

Activating Items at Startup 

FontAgent Pro provides several ways to reactivate fonts automatically when you restart your system. 

Activating Required Fonts 

FontAgent Pro leaves fonts required by your version of the Windows operating system in the Windows 
Fonts Control Panel. Windows automatically activates these fonts when your computer starts up. While 
FontAgent Pro displays these fonts in the Required Fonts library, you cannot use FontAgent Pro to 
deactivate or remove these fonts.  

Designating Startup Fonts, Styles, Families, Sets and Libraries 

You can specify fonts you want FontAgent Pro to activate when it starts up. You can tell FontAgent Pro to 
activate individual fonts, sets of fonts, an entire library of fonts, and even specific font styles. You can 
create as many startup items as you desire, but remember that each one consumes a bit more system 
resources and adds more clutter to your font menus.  

To automatically activate an item in FontAgent Pro at startup, right-click it and choose Add to Startup 
Items. To define multiple items as startup items, use Ctrl-Click and Shift-Click to select them all, and then 
select the Add to Startup Items command from the Tools menu. FontAgent Pro marks each item you select 
with a curved up-arrow after its name. 

When you mark a library or set as a startup item, FontAgent Pro automatically activates all the fonts it 
contains the next time FontAgent Pro starts. 

 

Canceling Startup Items 

To stop an item from activating at startup, right-click it and select Remove from Startup Items. To stop 
multiple items from starting up, use Ctrl-Click or Shift-Click to select all of them, and select the Remove 
from Startup Items command from the Tools menu. 

Note: When you cancel an item from starting up, you do not activate it in the current FontAgent Pro 
session. If you wish to deactivate an item, select it and click the Deactivate button in the toolbar. 
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Setting Startup Preferences 

To set startup preferences in FontAgent Pro, select the Preferences command from the Edit menu and the 
following dialog appears. 

 

Launch FontAgent Pro when current user logs in… 

Check this option to have Windows launch FontAgent Pro automatically when a user logs in. If you check 
this option, you can also check a combination of Alt, Ctrl and Shift keys that you can press during login to 
avoid starting FontAgent Pro.  

On startup, activate fonts active at end of last session 

Check this option to have FontAgent Pro reactivate fonts that were activated at the end of the previous 
FontAgent Pro session. Note that any fonts residing in the Required Fonts library, as well as those marked 
as startup items will appear active at the start of any FontAgent Pro session.  

Custom Text for Font Player and Font Compare 

Enter the text string that Font Compare should use to display samples of selected fonts. Font Player 
displays the same string when you ask it to display Custom Text. To change this string in either viewer, 
click the Text button.  



 

 
FontAgent Pro 4 User Guide 43 

Working with Libraries 

FontAgent Pro allows you to create and open multiple font libraries, a unique and powerful capability. 
Each FontAgent Pro library is a separate, physical collection of font files. 

Using multiple libraries allows you to keep fonts from different projects or clients separate from each 
other. When you are performing work for a specific client or project, activate only fonts from the 
appropriate library and you can be sure you are using the correct fonts. 

Although FontAgent Pro prevents you from duplicating fonts in a single library,  
you can store the same or similar fonts with the same name in separate libraries. 

In general, if you don’t have multiple versions of the same font, rather than organizing your fonts into 
multiple libraries, it’s best to create one large library and use sets to define logical groups of fonts.  

If you work primarily with your own fonts and do not receive fonts from outside sources, you can probably 
store your font collection in one library. On the other hand, using multiple libraries can help you ensure 
that you use exactly the right fonts when:  

• You receive fonts from outside sources and wish to separate your client’s fonts from your own 
• You wish to use specific fonts for certain projects and delete them from your machine when the 

project is finished 
• You are working with tweaked versions of fonts that differ slightly from their original versions, 

but still have the same font name 

By using libraries and sets properly, you can easily determine which font is used for a specific project or 
client. In addition, you can use FontAgent Pro to export the library for sending to a print service bureau to 
ensure they are using the correct fonts for your documents. 

Creating Libraries 

To create a new, empty library into which you can import fonts, either click the New Library icon in the 
toolbar or select New Library from the File menu. FontAgent Pro creates a library called New Library and 
selects its name so you can type a new name for the library. 
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Deleting Libraries 

Deleting a library or deleting fonts from a library permanently deletes the selected fonts from the hard 
drive. See HUDeleting FontsUH for more information. 

Select a font, group of fonts or library and click the Delete button in the toolbar or press the Delete key. A 
dialog box appears asking you to confirm that you wish to delete the selected fonts. Deleting from a library 
permanently deletes the selected fonts from your hard drive. 

Copying Fonts between Libraries 

To copy fonts between libraries, drag and drop them from one library to the other. You may find it helpful 
to click the Libraries tabs in both work areas to make it easier to drag fonts to and from different libraries. 
When copying, FontAgent Pro imports fonts into the target library and optimizes them, ensuring that it 
copies only unique, complete fonts. 

Using Special Libraries 

If you choose to optimize your Fonts Control Panel, FontAgent Pro creates two special libraries for you.  

The Required Fonts library contains all the fonts that Microsoft ships with your version of the Windows 
operating system. Windows expects to find the files for these fonts in the C:\Windows\Fonts folder, so 
FontAgent Pro leaves them there. FontAgent Pro locks this library so its fonts cannot be deleted. To ensure 
that Windows functions properly, you cannot unlock the Required Fonts library.  

The other library created by FontAgent Pro is named Control Panel Fonts. This library contains the rest of 
the valid fonts FontAgent Pro finds in your Fonts Control Panel. If you wish, you can rename the Control 
Panel Fonts library to a name of your choosing. 

Note: Inside FontAgent Pro, fonts moved by the Control Panel optimization process appear in the All Fonts 
tab and the Control Panel Fonts library. In Windows Explorer, the moved fonts appear in alphabetical 
folders by their filename inside your FontAgent Pro data folder, whose default parent directory is 
C:\FAP_Data.  

 



 

Using Font Player 

FontAgent Pro’s Font Player provides very useful font previewing and printing functionality. It 
automatically previews the font you currently have selected, displaying it in the Font Player window in a 
customizable text string, size and color. If you have selected a font family, library or set, FontAgent Pro 
displays the first font in that selection in Font Player. 

 

Playing Your Fonts 

Font Player also includes the ability to “play” or automatically cycle through a selection of fonts. To use 
Font Player, you can: 

1 Select a group of fonts, sets or libraries 
2 Use the pull-down list to select text to display. Choose from an ABC123 glyph set, a standard 

paragraph or you own text that you can enter by selecting Custom Text and clicking the Text 
button.  

3 Press the < or > buttons to move to the previous or next font. 
4 Press the >> button to display the text in the Font Player window in each font you have 

selected, one after the other. The slider adjusts the speed at which Font Player displays the 
fonts. 

Creating a Set of Favorite Fonts 

To mark a font as Font Player displays it, click the + button and FontAgent Pro records that font in a special 
set called Font Player Set. This provides a convenient way to collect your favorite fonts when playing 
through a large group of fonts. If you wish to save the set you have created, you can rename Font Player Set 
to another name. To do so, see HURenaming SetsUH.  
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Font Player Controls 

 Item Button Function 

Name - Displays the font's name. 

Size 
 

Displays current font point size. Enter a numeric point size or use the up 
and down arrows to change the point size.  

Text 
 

Displays a dialog so you can enter text to be used as the Custom Text 
string in Font Player. Available only when you have selected Custom 
Text.  

Text color 
 

Displays a color palette so you can select the text color. 

Background color 
 

Displays a color palette so you can select the background color.  

Print  
 

Outputs the currently selected fonts to a printer (or a pdf file if you have 
a pdf creation utility such as Adobe Acrobat). 

Record  
 

While playing through a group of fonts, you can click the Record button 
to mark the current font as a favorite and place it in a set called Font 
Player Set.  

Next font 
 

Display the next selected font. 

Previous font 
 

Display the previous font in the selection. 

Play forward 
 

Display all selected fonts in the order in which they are selected. 

Play backward 
 

Display all selected fonts in the inverse order in which they are selected. 

Stop playing 
 

Stop auto-playing fonts in the Font Player. 

Speed slider  Slide to the left to play fonts slower, or to the right to play faster.  

 



 

You can also specify the sample text that Font Player displays by selecting one of the following options in 
the pull-down box. 

 

  

 

 

 

 

 

   

To enter you own custom text, select Custom Text and click the Text button.  
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Using Font Compare 

FontAgent Pro’s Font Compare displays sample text in multiple fonts for easy comparison. After you select 
fonts, families, sets or libraries, Font Compare displays a text string of your choosing in each of your 
selected fonts. You can select the fonts to display or create a favorite set of fonts as explained above and 
view all the fonts in the set Font Compare Controls 

 

 Item Button Function 

Text - Click to enter the text to display. 

Size 
 

Displays current font point size. Enter a numeric point size or use the up 
and down arrows to change the point size.  

Change text color 
 

Displays a color palette so you can select the text color.  

Change 
background color  

Displays a color palette so you can select the background color. 

Print button 
 

Outputs the currently selected fonts to a printer (or a pdf file if you 
have a pdf creation utility such as Adobe Acrobat). 



 

Printing Font Sample Books 

Font Player and Font Compare also include powerful functionality for printing font specimen books. These 
books allow you to view a standard or custom text string displayed in various fonts, send proofs to clients 
for feedback and keep visual records of your fonts. To create a font specimen book, follow these steps: 

1 Select a group of fonts, sets or libraries. 
2 Choose the text you want to print by either clicking on one of the content buttons or typing in 

your own text. 
3 Click the printer icon to display the Print dialog box, where you can choose whether you would 

like to print to a printer or to a PDF file for electronic distribution. 

IMPORTANT: If you print using a PDF print driver such as Adobe PDF, be sure you have configured the 

printer definition to download fonts to the PDF file. Failing to do so can cause garbled text to appear in 
your PDF output.  
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Exporting Fonts 

Exporting fonts saves selected font files in 
the folder location you choose. This allows 
you to gather fonts for distribution to 
associates, clients or print service bureaus 
and ensure that the fonts you are sending are 
verified and complete. 

To export fonts, select a group of fonts, sets 
or libraries and select Export Fonts from the 
File menu. The Export dialog box appears, 
allowing you to specify a name and location 
of the folder to which fonts can be exported.  

Select a file location, click Export and 
FontAgent Pro places a copy of the font files 
in folder called Exported Fonts at the selected 
location. 

Locking Fonts, Families, Sets and Libraries  

Locking Fonts 

Locking fonts in FontAgent Pro protects you from accidentally 
deleting fonts from your font database. When a font is locked, a 
padlock icon appears next to its name indicating that you 
cannot remove the font, but that you can still activate and 
deactivate it.  

To lock a font, select it and click the Lock button in the toolbar. To unlock a font so you can modify or 
remove it, select it and click Unlock. You can also right-click on a font’s name and select Lock or Unlock from 
the pop-up menu that appears. 



 

Locking Font Families 

When you lock a font family in FontAgent Pro, you are really locking all of the fonts it contains. To lock or 
unlock a font family, select the family name and click the Lock or Unlock tile in the toolbar. When a family 
of fonts is locked, you cannot modify or delete them, but you can still activate and deactivate them.  

Locking Sets 

When you lock a set in FontAgent Pro, you cannot move or change 
the set, nor the fonts it contains. Fonts and subsets residing inside 
a locked set appear with an up-arrow lock to denote they are 
contained in a higher-level parent set that is locked.  

To lock or unlock a set, select its name and click the Lock or Unlock tile in the toolbar. When a set is locked, 
you cannot modify or delete them, but you can still activate and deactivate them. 

Locking Libraries 

Locking a library in FontAgent Pro protects you from deleting or moving important fonts. Fonts residing in 
a locked library appear with an up-arrow lock to denote they are contained in a locked parent library.  

To lock or unlock a library, select its name and click the Lock or Unlock tile in the toolbar. Note that some 
fonts inside an unlocked library may still appear with lock icons if they have been locked individually or if 
they are contained in a locked set. 

Locking the Required Fonts Library 

The Required Fonts library contains all the fonts that Microsoft ships with your version of the Windows 
operating system. Windows expects to find the files for these fonts in the C:\Windows\Fonts folder, so 
FontAgent Pro leaves them there. FontAgent Pro locks this library so its fonts cannot be deleted. To ensure 
that Windows functions properly, you cannot unlock the Required Fonts library or the fonts it contains.  
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Installing and Using Auto-Activation Plug-Ins 

FontAgent Pro provides plug-in software that you must install to enable automatic font activation in 
Adobe InDesign, Adobe Photoshop and Adobe Illustrator.  

Manually Installing Auto-Activation Plug-Ins 

FontAgent Pro lets you elect to install auto-activation plug-ins manually rather than using the Plug-in 
Wizard. To do so, locate the plug-ins in FontAgent Pro’s application folder named C:\Program Files\Insider 
Software\FontAgent Pro 4\plugins\. To install a specific plug-in, drop the plug in file into the appropriate 
folder.  

Auto-Activating Fonts in Adobe InDesign CS 2 and CS 3 

FontAgent Pro includes plug-ins for Adobe InDesign CS 2 and CS 3 that enable automatic font activation. 
Once installed, FontAgent Pro automatically activates any fonts required by InDesign documents. 
FontAgent Pro’s tight integration with InDesign ensures that the correct fonts are activated.  

Installing the plug-in for InDesign CS2  

Copy the file called FAPIDCS2.pln to the \Adobe\Adobe InDesign CS2\Plug-ins folder. If necessary, re-launch 
the InDesign application to load the plug-in. 

Installing the plug-in for InDesign CS3  

Copy the file called FAPIDCS3.pln to the \Adobe\Adobe InDesign CS3\Plug-ins folder. If necessary, re-launch 
the InDesign application to load the plug-in. 

Enabling auto-activation 

From the Edit menu, select Preferences, in the Auto-activation section, check Enable auto-activation of 
fonts. InDesign may display a dialog explaining that fonts are missing before the fonts are auto-activated. 
Click OK to dismiss the dialog. If any needed fonts aren’t activated, InDesign can highlight the problem 
text. Select Preferences->Composition from the Edit menu and check Substituted Fonts. To perform a 
thorough check, from the File menu, select Preflight, click Fonts and check Show Problems Only. 

Auto-Activating Fonts in Adobe Photoshop CS 2 and CS3 

FontAgent Pro includes two plug-ins that enable automatic font activation in Adobe Photoshop CS 2 and 
CS 3. Once installed, FontAgent Pro automatically activates any fonts required by Photoshop documents. 
FontAgent Pro’s tight integration with Photoshop ensures that the correct fonts are activated.  

Installing the plug-in for Photoshop CS2  

Copy the file called FAPHelperPSCS2.8li and the FAPPSCS2.8li to the \Adobe\Adobe Photoshop CS2\Plug-ins 
folder. If necessary, re-launch the Photoshop application to load the plug-in. 

Installing the plug-in for Photoshop CS3  

Copy the file called FAPHelperPSCS3.8li and the FAPPSCS3.8li to the \Adobe\Adobe Photoshop CS3\Plug-ins 
folder. If necessary, re-launch the Photoshop application to load the plug-in. 
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Enabling auto-activation 

From the FontAgent Pro menu, select Preferences, then the Activation tab and check Enable auto font 
activation. Photoshop may display a missing fonts dialog before the fonts are auto-activated. Click Open to 
dismiss the dialog.  

Auto-Activating Fonts in Adobe Illustrator CS 2 and CS 3 

FontAgent Pro includes plug-ins that enable automatic font activation in Adobe Illustrator CS 2 and CS 3. 
Once installed, FontAgent Pro automatically activates any fonts required by Illustrator documents. 
FontAgent Pro’s tight integration with Illustrator ensures that the correct fonts are activated.  

Installing the plug-in for Illustrator CS2  

Copy the file called FAPIDCS2.pln to the \Adobe\Adobe Illustrator CS2\Plug-ins folder. If necessary, re-
launch the InDesign application to load the plug-in. 

Installing the plug-in for Illustrator CS3  

Copy the file called FAPIDCS3.pln to the \Adobe\Adobe Illustrator CS3\Plug-ins folder. If necessary, re-
launch the Illustrator application to load the plug-in. 

Enabling auto-activation 

From the FontAgent Pro menu, select Preferences, then the Activation tab and check Enable auto font 
activation. Illustrator may display a missing fonts dialog before the fonts are auto-activated. Click Open to 
dismiss the dialog. To verify that all the fonts in the document were available, select Type->Find Fonts 
from the menu. Any missing fonts are identified with an asterisk after the font name. 
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Checking for Software Updates 

Insider creates new versions of FontAgent Pro on an ongoing basis and makes them available for 
download from the Insider website at HUwww.insidersoftware.comUH. By downloading and installing these 
new versions, you improve the functionality, performance and reliability of your FontAgent Pro software 
and your computer. 

Determining the Current Version Number 

To determine the current version of your FontAgent Pro software, select the Help>About FontAgent Pro 
menu command. This information is helpful when requesting technical support and when making 
decisions about when to update your FontAgent Pro installation. 

Automatically Checking for Updates 

The first time you start FontAgent Pro with an active Internet connection, it checks the Insider Software 
website for the most recently released version number of the program. If the version is newer than the one 
you are running, FontAgent Pro posts the following dialog. 
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Click one of the buttons explained in the table below to tell FontAgent Pro what you’d like to do about the 
new version. 

Button Action 

Exit and update now Exit FontAgent Pro and download the new version from the Insider  website. Before 
installing the new version by running the installer from Windows, you must uninstall 
the current version of FontAgent Pro. 

Remind me tomorrow Starting tomorrow, FontAgent Pro will remind you about the update the first time you 
start the program. 

Remind me in one week Starting a week from now, FontAgent Pro will remind you about the update the first 
time you start the program. 

Don’t remind me again FontAgent Pro will not remind you about updates again. To check for updates, use the 
Tools>Check for Updates menu command. 

Manually Checking for Updates 

Whenever you have a live Internet connection, you can check if you have the most current version of 
FontAgent Pro by using the Tools>Check for Updates menu command, which posts the dialog that appears 
above.  
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Index 

A 
Activate button, 38 
activating fonts 

at startup, 41 
described, 38 
effect on Font menus, 38 
effect on system memory, 38 
from previous session, 42 
indicators for, 26 
manually, 38 

activation icons, pictured, 26 
activation, defined, 9 
adding fonts to sets, 37 
Adobe applications 

auto-activation in Illustrator, 53 
auto-activation in InDesign, 52 
auto-activation in PhotoShop, 52 

Adobe PDF output, 49 
All Fonts tab 

duplicate fonts in, 35 
importing fonts into, 17 
using the, 30 

application fonts, 23 
archive, defined, 9 
archiving fonts, 15 
Asian character fonts, 8 
auto-activating fonts 

in Adobe Illustrator, 53 
in Adobe InDesign, 52 
in Adobe PhotoShop, 52 

Auto-activation 
errors, 40 
in Illustrator, 53 
in Photoshop, 52 
manual installation, 52 
setting in InDesign, 52 
setting preferences, 39 

B 
backing up fonts, 15 

C 
cascading sets. See subsets..  
color, text 

changing in Font Compare, 48 
changing in Font Player, 46 

Control Panel Fonts library 
described, 16 

locking, 16 
using, 44 

control panel fonts, defined, 9 
copying fonts between libraries, 44 
copying sets, 37 
corrupt fonts 

detecting, 21 
effects of, 5 

customer fonts 
using libraries to organize, 43 
using sets to organize, 35 

D 
database, specifying location of font, 12 
Deactivate button, 38 
deleting items 

fonts, 31, 32 
sets, 37 

designer, defined, 9 
destination library, 19 
downloading software updates, 54, 55 
duplicate fonts 

detecting, 21 
effects of, 5 

E 
exporting fonts 

to folders, 50 
using to create backup copies, 32 

F 
family 

activating at startup, 41 
defined, 9 
locking, 51 

FAQs, online, 7 
file format. See formats.  
file, location of font, 27 
filenames 

converting to real font names, 6 
cryptic Windows, 6 

Filter field, 30 
folder, show font file in, 27 
Font Compare 

controls for using, 48 
described, 48 
setting custom text string, 42 

font file, location of, 27 
font file, location of, 44 
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Font Player 
controls for using, 46 
described, 45 
entering custom text in, 46 
setting custom text string, 42 

fonts 
defined, 9 
locating font files, 44 

Fonts Control Panel 
importing fonts residing in, 13, 38 
library for, 16 
location of files in, 8 
organizing your, 6 
restoring, 24 

formats 
defined, 9 
described, 8 
icons for various, 26 
supported by Mac OS X, 8 

foundry 
defined, 9 
sorting by, 26 

H 
help, launching, 7 

I 
import, defined, 10 
importing fonts 

Last Import set, 22 
methods for, 19 
options, 19 
using toolbar for, 31 

incomplete fonts 
detecting, 21 
effects of, 5 

Internet, finding fonts on the, 33 

K 
Keyword Search 

activating fonts from, 33 
purchasing fonts from, 34 
using, 33 

L 
Last Import set, 22 
launching FontAgent Pro at login, 42 
libraries 

activating at startup, 41 
copying fonts between, 44 

creating new, 43 
defined, 10 
defining sets that span, 35 
deleting, 31, 44 
deleting fonts from, 32 
described, 43 
destination when importing, 19 
duplicate fonts in, 35 
file location of, 16 
locking, 51 
organizing fonts in sets versus, 43 
organizing fonts into, 6 
reasons for using multiple, 43 
sorting fonts within, 26 
why use multiple, 6 

locking items 
families, 51 
fonts, 50 
libraries, 51 
no effect on activation, 38 
Required Fonts library, 44, 51 
sets, 37, 51 
using toolbar, 31 
Windows-required fonts, 15 

M 
memory, saving with font activation, 38 

N 
name, sorting by font, 26 
nested sets. See subsets..  

O 
OpenType format 

described, 8 
icon for, 26 

optimized font, defined, 10 
optimizing Fonts Control Panel 

described, 13 
importing non-required fonts, 16 
importing Windows-required fonts, 15 

P 
panes 

Preview Area, 25 
Work Areas, 25 

pdf file 
creating in Font Compare, 48 
creating in Font Player, 46 
defined, 10 
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gibberish appearing in, 49 
point size 

changing in Font Compare, 48 
changing in Font Player, 46 
defined, 10 

Preview Area, 25 
previewing fonts 

using Font Compare, 48 
using Font Player, 45 
using WYSIWYG mode, 30 

printing font sample books, 49 
printing pdf files 

using Font Compare, 48 
using Font Player, 46 

problem fonts 
defined, 10 
location of, 20 

Problem Fonts folder, 17, 19 
project fonts 

using libraries to organize, 43 
using sets to organize, 35 

properties 
viewing in tabs, 26 

purchasing fonts off the Internet, 34 

R 
renaming sets, 37 
reports 

displaying after importing, 17, 19 
required fonts 

described, 15 
importing into other libraries, 15 

Required Fonts library 
activating fonts in, 41 
described, 15 
locked, 51 
using, 44 

restoring Fonts Control Panel, 9, 15, 16, 24 

S 
sample book, defined, 10 
scrolling to items by typing, 31 
searching fonts. See filtering.  
selecting fonts, 28 
sets 

activating at startup, 41 
adding fonts to, 37 
cascading, 36 
copying, 37 
creating favorite font, 45 
creating new, 31 
defined, 10 

deleting, 31, 37 
locking, 51 
nested, 36 
no effect on physical font files, 35 
organizing fonts in libraries versus, 35 
renaming, 37 
spanning multiple libraries, 35 

Shift-click to select multiple items, 28 
Show File command, 27 
size, font. See point sizes.  
sorting font lists, 28 
specimen sheet, defined, 10 
speed, controlling in Font Player, 46 
spheres, as activation indicators, 26 
startup item 

creating, 41 
defined, 11 

styles 
activating at startup, 41 
defined, 11 

subsets 
creating, 36 
defined, 11 

substitution, font, 5 
support, technical, 7 
system fonts. See required fonts.  

T 
technical support, 7 
Text button 

in Font Player, 46, 47 
text color 

changing in Font Compare, 48 
changing in Font Player, 46 

toolbar 
functions described, 31 
Import Fonts button, 18 
pictured, 31 

TrueType format 
described, 8 
icon for, 26 

Type 1 format 
described, 8 
icon for, 26 

typeface, defined, 11 

U 
unmatched fonts. See incomplete fonts.  
updates 

automatically checking for, 54 
manually checking for, 55 
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V 
version number, determining, 54 
viewing fonts. See previewing fonts.  

W 
website, 7 

weight, defined, 11 
width, defined, 11 
Windows fonts directory See Fonts Control Panel.  
Windows TrueType format 

described, 8 
icon for, 26 

Windows, fonts required by, 15 
Work Areas, 25 
WYSIWYG mode, 6, 30 

 


